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file commands



New command (File menu)

Creates a new Home Page. If you have a Home Page open, the new Home Page opens over the current 
one. Home Page Author lets you to create a Home Page for your web site. You may want to create 
several Home Pages. For example, you might want to have a Home Page on recreation and another on 
newsgroups. The New command clears the Home Page Author window of all Home Page icons so that 
you can start a new Home Page.

Commands: New

Shortcuts: Ctrl+N
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Open command (File menu)

Loads a Home Page into Home Page Author. If you already have a Home Page open, Home Page Author
opens it over the original. Home Page Author lets you create several Home Pages for different topics. For 
example, you might want to have one Home Page to display sports topics and another Home Page to 
display news topics. The Open... command lets you load a previously saved Home Page.

Commands: Open...

Shortcuts: Ctrl+O
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Save command (File menu)

Saves your Home Page under the name displayed in the title bar. If you have not saved the Home Page 
yet, the Save Home Page dialog box appears prompting you to enter a name. If you are altering an 
existing Home Page, but want to keep the original version, use the Save As command.

Commands: Save

Shortcuts: Ctrl+S
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Save As... command (File menu)

Saves a new Home Page or a new version of an existing Home Page. Also lets you save the contents of 
the currently displayed page. If you are altering an existing Home Page, but want to keep the original 
version, use the Save As command. Home Page Author lets you create several Home Pages. You may 
want to use different Home Pages to organize your topics. For example, you might want to have one 
Home Pages display sports topics and another Home Page display news topics. The Save As... 
command lets you save the Home Page in the current Home Page Author directory with a new name.

Commands: Save As...

Shortcuts: N/A
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Most Recently Opened Files command (File menu)

Home Page Author keeps the names of the four most recently opened Home Pages are kept at the 
bottom of the File menu. These menu entries provide a shortcut to opening these Home Pages.
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Exit command (File menu)

Ends the current Home Page Author session. If you've made any changes since you last saved your file, 
Home Page Author prompts you to save the file before exiting. If you want to stop Home Page Author 
from running on your system, you can exit the application. You may also run other applications and leave 
Home Page Author running in the background.

Commands: Exit

Shortcuts: Alt+F4

Note
If you want to leave Home Page Author running in the background, from the System menu, choose the Minimize 

command.
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Close command (File menu)

Closes the current Home Page. If you've made any changes since you last saved your file, Home Page 
Author prompts you to save the file before closing.
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Right Mouse Button



Undo command (Right Mouse Button)

The Undo command reverses actions performed during the current session. Use Undo after making a 
change you do not want implemented. Immediately after selecting Undo, the Redo command becomes 
available, allowing you to restore what you just undid. The Undo command changes depending on the 
last action. If the action cannot be undone, or if there are no actions to be undone, the command is 
grayed. If the action cannot be undone, the Undo command changes to "Can't Undo".

Note
You cannot Undo any file operations (Open, Save, Close, etc.)
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Cut command (Right Mouse Button)

Removes selected text from the current Home Page and places it onto the Clipboard. From the Clipboard,
you can paste it into another text box of the Home Page Author. The Cut command lets you remove a 
selection of text from the Home Page Author window and keep the information on the Windows Clipboard.
You can paste the text back into the same window or you can open another Home Page Author window 
and paste the selected text there.

Commands: Cut

Shortcuts: Ctrl+X

Notes
The Cut command is only available when you've selected text in the Home Page Author text box.
Text cut/copied from another Home Page Author copy are pasted into the current Home Page at the point clicked with the 

right mouse button.
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Copy command (Right Mouse Button)

Places a copy of the selected text onto the Clipboard. Once on the Clipboard, you can paste the text into 
another Windows application or another opened copy of Home Page Author. The Copy command lets you
duplicate text in Home Page Author. You can paste the duplicate selected text into the same window or 
you can open another copy of Home Page Author and paste the duplicate text there.

Commands: Copy

Shortcuts: Ctrl+C

Notes
The Copy command is only available when you've selected text in the Home Page Author window and clicked the right 

mouse button.
Objects copied from another open copy of the Home Page Author file are pasted into the current Home Page at the point 

clicked with the right mouse button.
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Paste command (Right Mouse Button)

Places a copy of the object(s) currently on the Clipboard into your Home Page. The original remains on 
the Clipboard until you copy or cut another selection of text, or end the current Windows session. If you've
used the Cut or Copy commands to place text on the clipboard, you can add the text to another Home 
Page Author text box that you currently have open using the Paste command.

Commands: Paste

Shortcuts: Ctrl+V

Notes
The Paste command is only available if you've copied text to the Windows Clipboard.
Objects cut/copied from another Home Page Author file are pasted into the current Home Page at the point clicked with 

the right mouse button.
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Delete command (Edit menu/Right Mouse Button)

The Delete command lets you remove one or more Home Page icons from the Home Page Author 
window. Deletes selected objects or text. If no further action has been performed, you can restore a 
deleted object using the Undo command.

Commands: Delete

Shortcuts: Delete
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Creating the Home Page



Header command (Insert menu)

Inserts a header on the Home Page. You apply a header to appear as a heading for a paragraph or page 
of text. The Home Page Author lets you add a subheading and center the header text.
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Separator command (Insert menu)

Inserts a separator on the Home Page. You can apply a separator anywhere in your text. It is a useful tool
to organize your text into manageable parts for easier reading. The Home Page Author lets you add or 
remove shading from the separator line.
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Body Text command (Insert menu)

Inserts a body of text on the Home Page. You can apply body text anywhere on the Home Page. Corel's 
Home Page Author lets you change the text to bold and italic. You can change the point size of the text by
choosing one of six different headers. Using Header 1 displays the largest point size and using Header 6 
displays the smallest point size.

Estimates on how big to make each document:
For online help, menus giving access to other things: small enough to fit on 24 lines.
For textual documents, of the order of half a letter-sized (A4) page to 5 pages.

Note
Unlike documents in most word processors, carriage returns in HTML files are insignificant. Word wrapping occurs at any 

point in Home Page, and multiple spaces are generally collapsed into a single space. The browser ignores any indentations or blank
lines in the Home Page's text. HTML relies almost entirely on the tags for formatting instructions, and without these tags, the 
document becomes a large paragraph. To preserve readability in HTML documents, headings should be on separate lines, and 
paragraphs or section of text should be separated by separators or blank lines.
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Link command (Insert menu)

Inserts a link on the Home Page. You can apply link anywhere on the Home Page. Corel's Home Page 
Author lets you change the link's text to bold and italic. You can change the point size of the text by 
choosing one of six different headers. Using Header 1 displays the largest point size and using Header 6 
displays the smallest point size. The link can open many different files. For example, if the link is a 
picture, then it may refer to one of several types namely: a bitmap (BMP), a JPeG, a GIF or a PCX. The 
success of a link depends on the web server. If the web server's database contains the file extension, the 
link from your Home Page should work. There are three parts to each link namely, the URL, the Page 
Name and the Description.

The Destination URL
The Uniform Resource Locator (URL) is the name of the file located when the reader clicks a link (page 
name). This is usually a text file but it can also be a BMP file for a graphic, a MID file for a song, an AVI 
file for a movie, etc. The list of different links is endless, yet the limitation rests with the web server and 
the audience you are targeting. Not everyone in your audience has the appropriate equipment or software
to view the type of file on your Home Page. Therefore, by using mostly text and a limited amount of 
graphics you can serve the largest audience. However, with the advent of the multimedia viewer, more 
people are able to see and hear different types of media.

The Link text
The Link Text is a word(s) highlighted by the browser with a different color or underlining. The reader 
clicks the highlighted word to connect to a different area of your text or to open another file.
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List command (Insert menu)

Inserts a bulleted list on the Home Page. You can apply a bulleted list anywhere on the Home Page. 
Corel's Home Page Author lets you change the list's appearance by choosing one of eight different styles.
Each of these styles display the bullets differently. For example, there are bullets displayed as symbols 
such as squares or discs. You may also choose from numbers, ordered lower case or capital letters, and 
lower case or capital roman numerals.
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List of Links command (Insert menu)

Inserts a list of links on the Home Page. You can apply a list of links anywhere on the Home Page. Corel's
Home Page Author lets you add many links to the list. Each link in the list opens a different file. For 
example, if the link is a picture, then it may refer to one of several types namely: a bitmap (BMP), a JPeG,
a GIF or a PCX. The success of a link depends on the web server. If the web server's database contains 
the file extension, the link from your Home Page should work. There are three parts to each link namely, 
the URL, the Page Name and the Description.

The URL
The Uniform Resource Locator (URL) is the name of the file located when the reader clicks a link (page 
name). This is usually a text file but it can also be a BMP file for a graphic, a MID file for a song, an AVI 
file for a movie, etc. The list of different links is endless, yet the limitation rests with the web server and 
the audience you are targeting. Not everyone in your audience has the appropriate equipment or software
to view the type of file on your Home Page. Therefore, by using mostly text and a limited amount of 
graphics you can serve the largest audience. However, with the advent of the multimedia viewer, more 
people are able to see and hear different types of media.

The Page Name
The Page Name is a word(s) highlighted by the browser with a different color or underlining. The reader 
clicks the highlighted word to connect to a different area of your text or to open another file.

The Description
The Description is a line of text describing where the reader will connect to , when they click the Page 
Name.
Icons as links make great navigational hints. It is preferable to use the same consistent icon throughout 
the work, always (except on the top page) linked back to the top page. This eliminates two problems at 
once. First, it gives consistency to the work, so readers know when they are in it and when they are 
outside it. Second, it gives them a quick way of getting back to the top of the Home Page. You can use 
icons with sections, so that at the top (or bottom) of each page you might have a small string of icons, the 
first to go back to the top of the work, the second to go back to the chapter, the third to go back to the 
section within the chapter.
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Definition List command (Insert menu)

Inserts a definition list on the Home Page. The browser places the word on the first line and its definition 
on the line below it. You can apply a definition list anywhere on the Home Page. Corel's Home Page 
Author lets you add multiple paragraphs of definitions to form a section of your Home Page text. 
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Image command (Insert menu)

Using images brings much needed color to your Home Page giving it a more polished appearance. You 
can apply an image anywhere on the Home Page. Corel's Home Page Author lets you change the 
image's appearance by centering the image and letting add alternate text. To locate the image, click the 
browse button.

Note
Unfortunately, HTML prevents you from surrounding your image with text, like in desktop publishing packages such as 

Corel Ventura. Therefore, it is preferable to use small images thereby sparing the reader from endless scrolling of your Home Page.
Most Web browsers can display in-line images (that is, images next to text) that are in X Bitmap (XBM) or (GIF) format. 

Each image takes time to send to the user and slows down the initial display of the document. Therefore, you should not include too 
many or overly large images. To speed up the processing of a large image, you may want to link to another document instead of 
incorporating the image in your Home Page.
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Marquee command (Insert menu)

Inserts a marquee on the Home Page. You can apply a marquee anywhere on the Home Page. Corel's 
Home Page Author lets you change the marquee's appearance by changing the behavior to scrolling, 
sliding or alternating. You can change the direction of the marquee from left to right or from right to left. 
You can choose from five different marquee behavior speeds.

Notes
When using a marquee, the scrolling or flashing of text may not work with some versions of web explorers.
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E-Mail Address command (Insert menu)

Inserts an E-Mail address on the Home Page. An E-Mail address is a location on the Internet where the 
reader can locate the information on the author of your Home Page. Doing this with the Home Page 
Author is easy -- all you have to do is put a link to a page about the author. Make a page for yourself with 
your mail address and phone number. At the bottom of your files, put a small note -- say just your name or
initials -- and link it to that page. Your author page is also a good location to put disclaimers and copyright 
notices. It saves cluttering up the messages themselves with a long signature.
You can apply an E-Mail address anywhere on the Home Page. Corel's Home Page Author lets you 
change the E-Mail address appearance by changing the Format string.

Note
If you are using the WorldWideWeb.app hypertext editor in conjunction with Corel's Home Page Author, then you can put 

this link from your default blank page so that it turns up on the bottom of each new document automatically.
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Getting Help



Contents command (Help menu)

Opens the Home Page Author Help Contents screen. From this screen, you can choose the type of Help 
you want. When you are in Help, clicking on the Contents button takes you back to the opening screen. 
Choosing the Contents command displays a list of topics available in this Help file.

Commands: Contents

Shortcuts: N/A
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About Page Wizard (Help menu)

Displays version information about Home Page Author’s Reader. Opens a dialog box with information 
about which version of Home Page Author you are running, and the amount of space available on the 
drive last used to save or open a file.
Clicking the System Info button opens the System Info dialog box.

Commands: About

Shortcuts: N/A
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Using Help command (Help menu)

If you require help performing any function in Home Page Author, extensive on-line help is included in the 
software. If you are unsure of the operation of any menu command or the procedure for a specific 
function, the on-line Help in Home Page Author can probably help you. You can browse through this Help 
file to become familiar with the help features available in Home Page Author.

Method of accessing Help Type of information provided

Help menu Choosing Contents from the Help menu displays the Help 
file's table of contents and lets you access the Help file's 
Index and full text search. Use the Help menu for 
overviews and explanations of procedures.

F1 Key Provides help on the currently selected object. For 
example, if you select a menu command and press F1, 
information on the use of the selected command is 
displayed.

Shift+F1 Keys Provides a context-sensitive help cursor (Show cursor). For 
example, you can press Shift+F1 and click a list box to 
view an explanation of that list box.

Right mouse click Provides information on the selected object. For example: 
right click the mouse on a check box and choose What's 
This? from the menu to view an explanation of that check 
box.

Help button Provides an overview of the current dialog box or window.

Status bar Provides a short description of the menu command you 
have currently selected.
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Keyboard Short-cuts

Function Keyboard Short-cut

Copy Ctrl+C
Ctrl+Insert

Cut Ctrl+X
Shift+Delete

Paste Ctrl+V
Shift+Insert

Delete Page Delete

Save Ctrl+S

Help 
Context Sensitive Help 

F1
Shift+F1
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Home Page Basics



What is the World-Wide Web

The official description describes the World-Wide Web as a "wide-area hypermedia information 
retrieval initiative aiming to give universal access to a large universe of documents."
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What is hypertext and hypermedia?

The Web system relies on hypertext as its means of interacting with users. Hypertext is similar to 
regular text - it can be stored, read, searched, or edited - with an important exception: hypertext 
contains connections within the home page text to other documents.
Hypermedia is a link that is more encompassing than hypertext - hypermedia documents contain links 
not only to text in other parts of your home page, but also to other types of media - sounds, images, 
and movies. These forms of media are now more commonly found in home pages, with the advent of 
multimedia viewers.

Note
The home page is like a book and it should be proofread. Furthermore, the home page also 

requires some testing of the hypertext and hypermedia. The author of the home page should ensure that 
the description accurately describes what is linked.
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What is HTML

HTLM (HyperText Mark-Up Language) is the standard ASCII mark up language for Internet hypertext. It
contains generic codes for hypertext browsers to interpret, much as postscript is interpreted by 
postscript printers.

Notes
Not all tags are supported by all World Wide Web browsers. If a browser does not support a tag, it

just ignores it.
Unlike documents in most word processors, carriage returns in HTML files are insignificant. Word 

wrapping occurs at any point in home page, and multiple spaces are generally collapsed into a single 
space. The browser ignores any indentations or blank lines in the home page's text. HTML relies almost 
entirely on the tags for formatting instructions, and without these tags, the document becomes a large 
paragraph. To preserve readability in HTML documents, headings should be on separate lines, and 
paragraphs should be separated by blanks lines.
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What is a Home Page

A Home Page is a HTML product used to display information to users of the Internet. When Internet 
users arrive at your web site; they see the Home Page that you created with Corel's Home Page 
Author. The Welcome page is often called a "home" page and is a good choice as a (default) page. 
The term "home" page means the default place to start your browser. The welcome page greets those 
new to your web site, who want an overview of its contents.

Note
Unlike documents in most word processors, carriage returns in HTML files are insignificant. Word 

wrapping occurs at any point in home page, and multiple spaces are generally collapsed into a single 
space. The browser ignores any indentations or blank lines in the home page's text. HTML relies almost 
entirely on the tags for formatting instructions, and without these tags, the document becomes a large 
paragraph. To preserve readability in HTML documents, headings should be on separate lines, and 
paragraphs should be separated by blanks lines or separators.
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Using the Home Page on the Internet

A Home Page helps you organize your information into manageable parts (sections) of text and 
images. You display these parts of text differently by using special tags. These tags take the form of 
headers, lists, separators and images. For example, you can add headers, separators, and lists 
anywhere on the home page. Corel's Home Page Author lets you change the color of the different parts
of text as well as the background. Corel's Home Page Author simplifies this process with drag and drop
functionality.
If you are a more sophisticated user, you can add links to other files that contain graphics or sounds. 
Also, you can add marquees that scroll, flash or slide across the screen.

Notes
When using a marquee, the scrolling or flashing of text may not work with some versions of web 

explorers.
Unlike documents in most word processors, carriage returns in HTML files are insignificant. Word 

wrapping occurs at any point in home page, and multiple spaces are generally collapsed into a single 
space. The browser ignores any indentations or blank lines in the home page's text. HTML relies almost 
entirely on the tags for formatting instructions, and without these tags, the document becomes a large 
paragraph. To preserve readability in HTML documents, headings should be on separate lines, and 
paragraphs should be separated by blanks lines.

The background must be in .GIF format for drag and drop functionality to work with the Home 
Page Author.
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Creating the Home Page



Using the Page Title

The Page Title is a line of text displayed in the title bar of the reader's browser. There may only be one 
title in any document. It should identify the content of the document in a fairly broad scope. The title is 
not part of the text of the home page, but is a property of the whole document and does not contain 
tags. The title is used primarily to identify documents in other contexts (e.g. a WAIS search). Ideally, 
the title should be less than 64 characters in length.
Many applications will display document titles in window title bar or menus where there is limited room. 
However, there is no limit on the length of a title (as it may be automatically generated from other data).
However, information providers are warned that it may be truncated if too long.
You enter or edit your page title in the text box of the Page Properties dialog box. This dialog box is 
accessed from the properties button of the Home Page Author.
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Using the Header

A header is text usually larger than the body text that is used to mark a paragraph or page. You apply a
header to appear as a heading for a paragraph or page of text. The Home Page Author lets you add a 
subheading and center the header text.
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Using the Separator

A separator is a graphic line that you apply onto the home page.You can apply a separator anywhere in
your text. It is a useful tool to organize your text into manageable parts for easier reading. The Home 
Page Author lets you add or remove shading from the separator line.
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Using the Body Text

A Body Text is a grouping of lines or paragraphs of text appearing on the home page.You can apply 
body text anywhere on the Home Page. Corel's Home Page Author lets you change the text to bold 
and italic. You can change the point size of the text by choosing one of six different headers. Using 
Header 1 displays the largest point size and using Header 6 displays the smallest point size.
Estimates on how big to make each document:

For online help, menus giving access to other things: small enough to fit on 24 lines.
For textual documents, of the order of half a letter-sized (A4) page to 5 pages.

Note
Unlike documents in most word processors, carriage returns in HTML files are insignificant. Word 

wrapping occurs at any point in home page, and multiple spaces are generally collapsed into a single 
space. The browser ignores any indentations or blank lines in the home page's text. HTML relies almost 
entirely on the tags for formatting instructions, and without these tags, the document becomes a large 
paragraph. To preserve readability in HTML documents, headings should be on separate lines, and 
paragraphs or section of text should be separated by separators or blank lines.
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Using the Link

A links is a connection to other documents or another area of the home page. You can apply a list of 
links anywhere on the Home Page. Corel's Home Page Author lets you add many links to the list. Each
link in the list opens a different file. For example, if the link is a picture, then it may refer to one of 
several types namely: a bitmap (BMP), a JPeG, a GIF or a PCX. The success of a link depends on the 
web server. If the web server's database contains the file extension, the link from your Home Page 
should work. There are three parts to each link namely, the URL, the Page Name and the Description.

The URL
The Uniform Resource Locator (URL) is the name of the file located when the reader clicks a link (page
name). This is usually a text file but it can also be a BMP file for a graphic, a MID file for a song, an AVI
file for a movie, etc. The list of different links is endless, yet the limitation rests with the web server and 
the audience you are targeting. Not everyone in your audience has the appropriate equipment or 
software to view the type of file on your Home Page. Therefore, by using mostly text and a limited 
amount of graphics you can serve the largest audience. However, with the advent of the multimedia 
viewer, more people are able to see and hear different types of media.

The Page Name
The Page Name is a word(s) highlighted by the browser with a different color or underlining. The 
reader clicks the highlighted word to connect to a different area of your text or to open another file.

The Description
The Description is a line of text describing where the reader will connect to , when they click the Page 
Name.
Icons as links make great navigational hints. It is preferable to use the same consistent icon throughout
the work, always (except on the top page) linked back to the top page. This eliminates two problems at 
once. First, it gives consistency to the work, so readers know when they are in it and when they are 
outside it. Second, it gives them a quick way of getting back to the top of the Home Page. You can use 
icons with sections, so that at the top (or bottom) of each page you might have a small string of icons, 
the first to go back to the top of the work, the second to go back to the chapter, the third to go back to 
the section within the chapter.
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Using the List

A list is an arrangement of text into single lines one below the other, each line starting with a bullet. You
can apply a bulleted list anywhere on the Home Page. Corel's Home Page Author lets you change the 
list's appearance by choosing one of eight different styles. Each of these styles display the bullets 
differently. For example, there are bullets displayed as symbols such as squares or discs. You may 
also choose from numbers, ordered lower case or capital letters, and lower case or capital roman 
numerals.
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Using the List of Links

A list of links is a grouping of links to other documents or another area of the home page. You can 
apply a list of links anywhere on the Home Page. Corel's Home Page Author lets you add many links to
the list. Each link in the list opens a different file. For example, if the link is a picture, then it may refer to
one of several types namely: a bitmap (BMP), a JPeG, a GIF or a PCX. The success of a link depends 
on the web server. If the web server's database contains the file extension, the link from your home 
page should work. There are three parts to each link namely, the URL, the Page Name and the 
Description.
The URL
The Uniform Resource Locator (URL) is the name of the file located when the reader clicks a link (page
name). This is usually a text file but it can also be a BMP file for a graphic, a MID file for a song, an AVI
file for a movie, etc. The list of different links is endless, yet the limitation rests with the web server and 
the audience you are targeting. Not everyone in your audience has the appropriate equipment or 
software to view the type of file on your Home Page. Therefore, by using mostly text and a limited 
amount of graphics you can serve the largest audience. However, with the advent of the multimedia 
viewer, more people are able to see and hear different types of media.

The Page Name
The Page Name is a word(s) highlighted by the browser with a different color or underlining. The 
reader clicks the highlighted word to connect to a different area of your text or to open another file.
The Description
The Description is a line of text describing where the reader will connect to , when they click the Page 
Name.
Icons as links make great navigational hints. It is preferable to use the same consistent icon throughout
the work, always (except on the top page) linked back to the top page. This eliminates two problems at 
once. First, it gives consistency to the work, so readers know when they are in it and when they are 
outside it. Second, it gives them a quick way of getting back to the top of the home page. You can use 
icons with sections, so that at the top (or bottom) of each page you might have a small string of icons, 
the first to go back to the top of the work, the second to go back to the chapter, the third to go back to 
the section within the chapter.
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Using the Definition List

A definition list is an arrangement of text into two lines. The browser places the word on the first line 
and its definition on the line below it. You can apply a definition list anywhere on the Home Page. 
Corel's Home Page Author lets you add multiple paragraphs of definitions to form a section of your 
home page text. 
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Using an Image

An image is an audio or visual representation of information found somewhere on your computer. 
Using images brings much needed color to your home page giving it a more polished appearance. You 
can apply an image anywhere on the Home Page. Corel's Home Page Author lets you change the 
image's appearance by centering the image and letting add alternate text. To locate the image, click 
the browse button.

Note
Unfortunately, HTML prevents you from surrounding your image with text, like in desktop 

publishing packages such as Corel Ventura. Therefore, it is preferable to use small images thereby 
sparing the reader from endless scrolling of your home page.

Most Web browsers can display in-line images (that is, images next to text) that are in X Bitmap 
(XBM) or (GIF) format. Each image takes time to send to the user and slows down the initial display of the
document. Therefore, you should not include too many or overly large images. To speed up the 
processing of a large image, you may want to link to another document instead of incorporating the image
in your home page.
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Using a Marquee

A marquee is a line of text that is animated in some way such as text that scrolls across the screen, 
flashes or slides on the screen. You can apply a marquee anywhere on the Home Page. Corel's Home 
Page Author lets you change the marquee's appearance by changing the behavior to scrolling, sliding 
or alternating. You can change the direction of the marquee from left to right or from right to left. You 
can choose from five different marquee behavior speeds.

Notes
When using a marquee, the scrolling or flashing of text may not work with some versions of web 

explorers.
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Using an E-Mail Address

An E-Mail address is a location on the Internet where the reader can locate the information on the 
author of your home page. Doing this with the Home Page Author is easy -- all you have to do is put a 
link to a page about the author. Make a page for yourself with your mail address and phone number. At 
the bottom of your files, put a small note -- say just your name or initials -- and link it to that page. Your 
author page is also a good location to put disclaimers and copyright notices. It saves cluttering up the 
messages themselves with a long signature.
You can apply an E-Mail address anywhere on the Home Page. Corel's Home Page Author lets you 
change the E-Mail address appearance by changing the Format string.

Note
If you are using the WorldWideWeb.app hypertext editor in conjunction with Corel's Home Page 

Author, then you can put this link from your default blank page so that it turns up on the bottom of each 
new document automatically.
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Working with Properties



Using Text Color to enhance the Home Page

Text color is the color of the alphanumeric characters of your text. You can apply a different color of text
to enhance the appearance of the Home Page. Using the color palette you can choose from an almost 
infinite variety of colors. The Color dialog box (as shown in Figure 1.13) displays the available colors 
and includes controls that allow you to define custom colors. You can use this control to provide an 
interface for users to select colors for an object.

Figure 1.13        The Color dialog box

The Basic colors control displays a default set of colors. The number of colors displayed here is 
determined by the installed display driver. The Custom colors control allows you to define more colors 
using the various color selection controls provided in the window.
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Using the Background to enhance the Home Page

The background is the color of the page where text is applied. You can apply a different background to 
enhance the appearance of the Home Page. Corel's Home Page Author lets you change the 
background to a solid color or an image that covers the entire page.
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Getting Started



How Home Page Author works

When you start Home Page Author for the first time, you need to add some formatting to the Home 
Page. Any formatting you add to the Home Page is displayed in the Preview. After you've added 
formatting, you must add the linked files into the same directory as the home page so that these links 
works properly.
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Creating a Home Page (step by step)
Create a Home Page

Before Home Page Author can start working for you, you have to tell it what information you want to 
display.
Set the Home Page Properties

After you’ve added at least one icon to your Home Page, you should set the properties so that Home 
Page Author displays the information correctly.
Preview the Home Page

If you want to view the page, just click on the Preview button of the Home Page and Home Page 
Author will attempt to display your Home Page in a browser. If Home Page Author can’t find your Web 
browser, you will have to tell Home Page Author where to find it.
You can now add as many icons as you want to the Home Page. There are many other functions that 
you can perform with Home Page Author. If you want some ideas, look at the How to section in this 
help file.
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Working with home page basics



To create a new Home Page
Click File, New.
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To open a home page
1.Click File, Open.
2. In the Look in list box, choose the drive where the file is stored.
3.Double-click the folder where the file is stored.
4.Double-click the Home Page’s file name.

Notes
If you try to open a Home Page that is already open, a message box appears asking you if you 

want to revert to the saved version of the Home Page. Click Yes to replace the open Home Page with the 
saved version. Click No to keep the open Home Page in its current state.

You can open a recently-saved file by clicking its name at the bottom of the File menu.
You can use wild cards (* and ?) if you're not sure of the name of the file you want to open. For 

example, typing test*.hpa in the File name box and clicking OK lists all HPA files in the selected directory 
beginning with test. "Typing test?".hpa in the File name box and clicking OK lists all HPA files in the 
selected directory that begin with test and are followed by one character (e.g., test1.hpa).

{button ,AL(`Working with home page basics;',0,"Defaultoverview",)} Related Topics



To Save As a new Home Page
1.Click File, Save As.
2. In the Save As list box, choose a drive and folder where you want to save your Home Page.
3.Type a name in the File name box.
4.Click Save.

{button ,AL(`Working with home page basics;',0,"Defaultoverview",)} Related Topics



To exit Home Page Author
Click File, Exit.

Note
If you have new Home Pages open, or Home Pages that you have modified, Home Page Author 

prompts you to save the changes prior to exiting.
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Editing the web page



To undo operations
Click Edit, Undo.

Note
Any file operation (open, saving, importing, etc.) cannot be reversed using undo:

{button ,AL(`Editing the web page;',0,"Defaultoverview",)} Related Topics



To cut text from the home page
1.Select text from your web page.
2.Click Edit, Cut.
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To copy text on the home page
1.Select text from your web page.
2.Click Edit, Copy.
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To paste text on the home page
1.Place your cursor on the web page where to paste text.
2.Click Edit, Paste.
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To delete text on the home page
1.Select text from your web page.
2.Click Edit, Delete.
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Working with text



To insert a header
Click Insert, Header.
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To remove a Header
1.Click the Header icon.
2.Click Edit, Delete.
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To insert a Separator
Click Insert, Separator.
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To remove a Separator
1.Click the Separator icon.
2.Click Edit, Delete.
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To insert Body Text
Click Insert, Body Text.
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To remove Body Text
1.Click the Body Text icon.
2.Click Edit, Delete.
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Working with lists



To insert a List
Click Insert, List.
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To remove a List
1.Click the List icon.
2.Click Edit, Delete.
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To insert a Definition List
Click Insert, Definition List.
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To remove a Definition List
1.Click the Definition List icon.
2.Click Edit, Delete.
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Working with links



To insert a Link
Click Insert, Link.
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To remove a Link
1.Click the Link icon.
2.Click Edit, Delete.
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To insert a List of Links
Click Insert, List of Links.
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To remove a List of Links
1.Click the List of Links icon.
2.Click Edit, Delete.
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Working with images and marquees



To insert an Image
Click Insert, Image.
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To remove an Image
1.Click the Image icon.
2.Click Edit, Delete.
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To insert a Marquee
Click Insert, Marquee.
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To remove a Marquee
1.Click the Marquee icon.
2.Click Edit, Delete.
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Working with the E-Mail address



To insert an E-Mail Address
Click Insert, E-Mail Address.
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To remove an E-Mail Address
1.Click the E-Mail Address icon.
2.Click Edit, Delete.
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Working with headings, subheadings and titles



To enter the heading text
1.Click the heading text box.
2.Type your text.
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To edit the heading text
1.Highlight the text in the heading text box.
2.Type your text.
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To remove the heading text
1.Highlight the text in the heading text box.
2.Press the Delete key.
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To enter the subheading text
1.Click the subheading text box.
2.Type your text.
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To edit the subheading text
1.Highlight the text in the subheading text box.
2.Type your text.
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To remove the subheading text
1.Highlight the text in the subheading text box.
2.Press the Delete key.
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To center the heading text
Enable the Center the header text checkbox.
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To preview the home page
Click the Preview button.
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To enter the page title
1.Click the Properties button.
2.Click the Page title box.
3.Type your text.
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To edit the page title
1.Click the Properties button.
2.Highlight the text in the Page title box.
3.Type your text.

{button ,AL(`Working with headings subheadings and titles;',0,"Defaultoverview",)} Related 
Topics



Coloring the home page



To change the text color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Text box.
4.Choose a color from the Basic colors palette.
5.Click OK.
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To change the link color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Link box.
4.Choose a color from the Basic colors palette.
5.Click OK.
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To change the seen link color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Seen Link box.
4.Choose a color from the Basic colors palette.
5.Click OK.
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To change the solid color background
1.Click the Properties button.
2.Click the Background tab.
3.Choose Solid Color Background from the list box.
4.Click the Pick Color button.
5.Choose a color from the Basic colors palette.
6.Click OK.
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Customizing colors on the home page



To customize the text color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Text box.
4.Click the Define Custom Colors button.
5.Mix your color using the color mixer controls on the right side of the Color box.
6.Click Add to Custom Colors.
7.Click OK.
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To customize the link color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Link box.
4.Click the Define Custom Colors button.
5.Mix your color using the color mixer controls on the right side of the Color box.
6.Click Add to Custom Colors.
7.Click OK.
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To customize the seen link color
1.Click the Properties button.
2.Click the Text Color tab.
3.Click the Seen Link box.
4.Click the Define Custom Colors button.
5.Mix your color using the color mixer controls on the right side of the Color box.
6.Click Add to Custom Colors.
7.Click OK.
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To customize the solid color background
1.Click the Properties button.
2.Click the Background tab.
3.Choose Solid Color Background from the list box.
4.Click the Pick Color button.
5.Click the Define Custom Colors button.
6.Mix your color using the color mixer controls on the right side of the Color box.
7.Click Add to Custom Colors.
8.Click OK.
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Changing the home page background



To use the default background color
1.Click the Properties button.
2.Click the Background tab.
3.Choose Default Background from the list box.
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To use the solid color background
1.Click the Properties button.
2.Click the Background tab.
3.Choose Solid Color Background from the list box.
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To use the bitmap background
1.Click the Properties button.
2.Click the Background tab.
3.Choose Bitmap Background from the list box.

{button ,AL(`Changing the home page background;',0,"Defaultoverview",)} Related Topics



To change the bitmap in the background
1.Click the Properties button.
2.Click the Background tab.
3.Choose Bitmap Background from the list box.
4.Click the Browse button.
5.Locate a bitmap.
6.Click OK.
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Working with Help



To open the online Home Page Author Help files
From the Help menu, choose the Contents command or press the F1 key.
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To display Help for a specific command
1.Highlight the command.
2.Press the F1 key.
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To display Help for a specific dialog box
Press the Help button on the dialog box.
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To display Help for window elements such as buttons and list boxes
Press the Shift and F1 keys at the same time and then click the element.
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To display the version of Home Page Author that you're using
From the Help menu, choose the About command.
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Opens the preferences dialog box and lets you make changes to the global settings of the Home Page 
Author.















































 Lets you define the page layout before printing.



 Lets you define the printer's parameters.



 Prints the selected object on the default printer.The Print dialog box, shown in Figure 8.9, allows you to 
select what to print, the number of copies to print, and the collation sequence for printing. It also allows 
you to choose a printer and provides a command button that provides shortcut access to that printer's 
properties.



 Lets you view the document in its entirety on the screen.



 Updates the file previously saved document with the changes you applied.



 Lets you create a backup copy of the current document and save it under a different name.
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Home Page Wizard Glossary



ANSI
The American National Standards Institute character set. It consists of 256 characters; the first 128 are 
the same as the ASCII character set.



ASCII
The American Standard Code for Information Interchange character set, which consists of the characters 
available on a standard 128 character keyboard, including non-printable control codes such as carriage 
returns and page breaks.



AVI
The filename extension (which stands for Audio Video Interleave) for a video for Windows file.



Background
Underlying elements common to all pages in a presentation. Backgrounds commonly consist of a 
repeating text or graphic element such as a company logo.



Bitmap
An image composed of a series of pixels or dots.



BMP
The filename extension for Windows bitmap files.



Bullet
A dot or other character used to differentiate items in a list or add emphasis.



Check box
A square box in a dialog box used to enable and disable options. An option is enabled when an X or a 
check mark appears in the check box, and is disabled when the check box is empty.



Click
To press quickly and release the left mouse button.



Clipart
Images that can be brought into Corel applications and edited or used as is. Corel offers a large selection 
of clipart in many formats. You can purchase additional images, including some in bitmap format, from 
commercial suppliers.



Clipboard
A temporary storage area used to hold cut or copied information. You can paste the contents of the 
Clipboard into other programs that support the type of information that has been cut or copied. 
Information remains on the Clipboard until another cut or copy command is executed.



Color palette
A collection of colors usually displayed in a dialog box activated by clicking Others.



Command
A word or phrase in a menu that initiates an action.



Cursor
Also called the mouse pointer. It indicates the command, tool, or other screen item you want to select.



Dialog box
A window displayed when additional information is needed to perform an action.



Double-click
To press and release the left mouse button twice in quick succession.



Drag
To move the mouse while holding down the left mouse button. Releasing the button completes the action.



Enable
An option is enabled when there is a check mark beside it.



Extension
The characters following the period in a filename that identify the type of information in the file. The .PCX 
extension, for example, indicates that the file contains a bitmap.



Font
A set of characters in a given typeface and point (see below). For example, 10 point Times Roman. Most 
fonts are available in families that include different weights or styles such as bold and italic.

10 pts    18 pts    36 pts



GIF
The filename extension for files in a bitmap format that is commonly used to store digitized color 
photographs. Corel applications can import files in this format.



Hue
In the HSB color model, hue is the main attribute in a color that distinguishes it from other colors. Blue, 
green, and red, for example, are all hues.



Hypermedia
Hypertext that includes or links to other forms of media.



Hypertext
Text that, when selected, has the ability to present connected documents.



Icon
A pictorial representation of a tool, object, file, or other program item. An item is selected by clicking once,
or sometimes double-clicking, on its icon.



Internet
The global collective of computer networks.



JPEG (Joint Photographic Experts Group)
An international standard for image compression that offers compression with almost no losses at ratios 
up to 20 to 1.



Linked object
In Object Linking and Embedding (OLE), information from a source file has been inserted into a file (the 
destination file), and maintains a link to the source file. Changes made to the information in the source file
are automatically made to the information in the destination files.



Marquee
A animated line of text that scrolls, flashes or slides on the computer screen.



Menu
A list of commands that appears when you choose a name in the menu bar. The menu bar appears below
the title bar which is at the top of the window.



Menu bar 
The bar near the top of the window that contains the names of the program menus.



Paste
To place something from the Windows Clipboard into the active area.



PCT
The filename extension for vector graphics files used by Macintosh computers.



PCX
The filename extension for bitmap files created by paint programs such as PC Paintbrush.



Point size
Typographic unit of measurement equal to 1/72 inch.

10 pts      18 pts      36 pts



PostScript
A page-description language or protocol by which programs describe text and graphics output they want 
for a printer.



Saturation
Saturation is the purity of a color. The HSB color model uses Saturation as a component that determines 
the purity or intensity of a color. The more colors used to mix a color, the duller the color looks.



SGML
Standard Generalized Markup Language. A generic language for representing documents.



Title bar 
The bar along the top of a Windows application that contains the name of the application, the and the 
Maximize and Minimize buttons.



URLs
Uniform Resource Locators Standardized formatted entities within HTML documents which specify a 
network service or document to link to.



Alphabetical Index



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ANSI
ASCII
AVI

Bitmap
BMP

Caption bar
Check box
Click
Clipart
Clipboard
Close
Command
Cursor

Dialog box
Double-click

Enable
Extension

Font

GIF

Hypermedia
Hypertext



Icon
Internet

JPEG (Joint Photographic Experts Group)

Linked object

Maximize
Menu
Menu bar
Minimize
Move

PCX
Point size
PostScript

Restore

Scroll bar
Size
Switch To
System menu

Title bar

Uniform Resource Locator
URLs
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